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1. INTENDED USE

The BD OneFlow™ Plasma Cell Disorders Panel is intended for in vitro diagnostic use for qualitative flow-
cytometric immunophenotyping of plasma cell populations on a BD flow cytometer equipped with:

l A 488-nm blue laser, a 640-nm red laser, and a 405-nm violet laser
l The ability to detect forward scatter (FSC) and side scatter (SSC)
l At least eight-color fluorescence
l Software to acquire and analyze the data
The BD OneFlow™ Plasma Cell Disorders Panel is used as an aid in the differential diagnosis of
hematologically abnormal patients having, or suspected of having, plasma cell disorders. The BD OneFlow™
Plasma Cell Disorders Panel can be used with bone marrow specimens collected in EDTA or heparin tubes. The
results should be interpreted by a pathologist or equivalent professional in conjunction with other clinical or
laboratory findings.

The BD OneFlow™ Plasma Cell Disorders Panel comprises the following BD OneFlow™ tubes:

l BD OneFlow™ PCST (Plasma Cell Screening Tube)
l BD OneFlow™ PCD (Plasma Cell Disorders Tube)
Specific antigens contained in each BD OneFlow™ tube are listed as follows:

FITC PE PerCP-Cy5.5 PE-Cy7 APC APC-H7 V450a V500-Ca

PCST CD38 CD56 β2-microglobulin CD19 cyIgκb cyIgλ CD45 CD138

PCD CD38 CD28 CD27 CD19 CD117 CD81 CD45 CD138

a. BD Horizon™ V450, BD Horizon™ V500-C
b. cy refers to cytoplasmic

2. SUMMARY OF THE TEST

Plasma cell disorders (PCD) are a group of diseases most often characterized as having a clonal (neoplastic)
population of plasma cells in the bone marrow (BM).1 The cells may secrete a clonal immunoglobulin which
can be detected in the circulation. These disorders comprise several distinct diseases, including multiple
myeloma and monoclonal gammopathy of undetermined significance. The multicolor antibody panels are
used to characterize the cell populations in a patient specimen using immunophenotypic markers that are
indicative of normal and abnormal cells.
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The sample acquisition can be automated using the optional BD FACS™ Universal Loader when used with the
BD FACSLyric™ flow cytometer. This assay is not for automated sample preparation. Data analysis can be
performed using a pre-defined template and gating, however, reviewing all plots and adjusting gating
manually by the user are recommended.

Principle of Operation

The reagent tubes that comprise the BD OneFlow™ Plasma Cell Disorders Panel are composed of monoclonal
antibodies, each conjugated to a specific fluorochrome. The specimen is added to the reagent tube and
incubated, allowing each fluorochrome-conjugated monoclonal antibody in the reagent to bind to a specific
antigen. After incubation, the FIX&PERM® Cell Fixation and Permeabilization Kit is used to fix the stained cells
in suspension and to permeabilize the cell membranes. Cells are acquired on a BD flow cytometer using the
instrument software. During acquisition, the cells travel past the laser beam and scatter the laser light. The
stained cells fluoresce. These scatter and fluorescence signals, detected by the instrument, provide
information about the cell’s size, internal complexity, and relative fluorescence intensity. The instrument
software is used to analyze the data and report the result.

3. REAGENT

Reagent Composition

The BD OneFlow™ Plasma Cell Disorders Panel is composed of three single-use tubes containing the following
fluorochrome-conjugated antibodies in an optimized dried formulation. BD OneFlow™ PCST is composed of
two reagent tubes: BD OneFlow™ PCST (S) contains antibodies that recognize cell surface antigens, and
BD OneFlow™ PCST (C) contains antibodies that recognize cytoplasmic antigens. BD OneFlow™ PCD is
composed of one reagent tube which contains antibodies that recognize cell surface antigens. All of the
antibodies have IgG1 heavy chains and kappa light chains with the exception of ß2-Microglobulin, which has
IgM heavy chains. The antibody clone names are shown in the following table in the row beneath the
antibody.

Reagent FITC PE PerCP-Cy5.5 PE-Cy7 APC APC-H7 V450 V500-C

PCST (S) CD38
(HB7)2

CD56
(MY31)3,4

ß2-Micro-
globulin
(TÜ99)5

CD19
(SJ25-
C1)2,6

– – CD45
(2D1)7,8

CD138
(MI15)

9,10

PCST (C) – – – – Anti-
Kappa

(TB28-2)11

Anti-
Lambda

(1-155-2)11

– –

PCD CD38
(HB7)

CD28
(L293)12

CD27
(L128)13

CD19
(SJ25-C1)

CD117
(104D2)14

CD81
(JS81)15

CD45
(2D1)

CD138
(MI15)

Table 1 Antibody composition of BD OneFlow™ PCST and BD OneFlow™ PCD

The antibodies in the reagent tubes were chosen for their ability to identify and characterize plasma cells.

Refer to the article describing the EuroFlow antibody panels1 for a full description of the utility of the
antibodies chosen for the reagent tubes.

Precautions
l The reagent tubes contain 0.66% 2-methyl-4-isothiazolin-3-one (CAS number 2682-20-4). These reagents

are classified as hazardous according to the Globally Harmonized System of Classification and Labelling of
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Chemicals (GHS) and Regulation (EC) No 1272/2008.

Warning

H317: May cause an allergic skin reaction.
H412: Harmful to aquatic life with long lasting effects.

Prevention P261: Avoid breathing dust/fume/gas/mist/vapors/spray.
P272: Contaminated work clothing should not be allowed out of the workplace.
P273: Avoid release to the environment.
P280: Wear protective gloves/protective clothing/eye protection/face protection.

Response P302+P352: IF ON SKIN: Wash with plenty of soap and water.
P333+P313: If skin irritation or rash occurs: Get medical advice/attention.
P362+P364: Take off contaminated clothing and wash it before reuse.

P501: Dispose of contents/container to an approved facility in accordance with local, regional,
national and international regulations.

• Go to regdocs.bd.com/regdocs/sdsSearch to download the Safety Data Sheet.

Storage and Handling
l Store tubes at 2–27 °C in the foil pouch.
l Do not freeze the reagent or expose it to direct light at any time during storage or incubation with cells.
l The dried fluorochrome-conjugated antibodies are stable until the expiration date shown on the pouch and

tube labels when stored as directed. Do not use after the expiration date.
l Once the pouch is opened, the dried fluorochrome-conjugated antibodies are stable for six months when

stored as directed.
CAUTION Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch.

4. INSTRUMENTS

The recommended BD systems are outlined. See the following table. See the corresponding reagent or
instrument user documentation for details.

Flow cytometer Setup beads Setup software Analysis software

BD FACSLyric™a BD® CS&T Beads
BD® FC Beads 7-Color Kit
BD® FC Beads 5-Color Kit
BD® FC Beads 2-Color Kit
(12-color instrument)

BD FACSuite™ Clinical
application v1.4 or laterb

BD FACSuite™ Clinical
application v1.4 or later

BD FACSCanto™ IIc BD FACSDiva™ CS&T IVD Beads
BD OneFlow™ Setup Beads
BD® FC Beads 8-Color Kit for
BD OneFlow™ Assays

BD FACSDiva™ software
v8.0.1 or later

BD FACSDiva™ software
v8.0.1 or later

a. 8-color (4-Blue 2-Red 2-Violet), 10-color (4-Blue 3-Red 3-Violet), or 12-color (4-Blue 3-Red 5-Violet)
b. The Loader can be used with the BD FACSuite™ Clinical application v1.5 or later
c. 3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical configuration

Table 2 Recommended BD systems
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The BD FACS™ Universal Loader can be used with these products. See the BD FACSLyric™ System Instructions
For Use for more information. The Loader can be used with BD FACSuite™ Clinical application v1.5 or later.

5. SPECIMEN COLLECTION AND PREPARATION

The BD OneFlow™ Plasma Cell Disorders Panel can be used for immunophenotyping by flow cytometry of
bone marrow (BM) aspirates.

l Collect BM specimens in BD Vacutainer® K2 or K3 EDTA blood collection tubes, or equivalent, or in lithium
or sodium heparin.

l We recommend that you follow guidelines described in consensus protocols for flow cytometric
immunophenotyping of hematopoietic malignancies.16,17

l Specimens should be processed up to 24 hours after collection.

Specimens with large numbers of nonviable cells can give erroneous results due to selective loss of
populations and to increased nonspecific binding of antibodies to nonviable cells. Viability of specimens
should be assessed. A minimum viability of 75% is recommended.18

l Samples should be acquired within 60 minutes of staining if kept at room temperature, protected from
light.

WARNING All biological specimens and materials coming in contact with them are considered biohazards.
Handle as if capable of transmitting infection19,20 and dispose of with proper precautions in accordance with
federal, state, and local regulations. Never pipette by mouth. Wear suitable protective clothing, eyewear, and
gloves.

Interfering Conditions

Substances present in the specimen might interfere with the assay:

l Use of therapeutic monoclonal antibodies in patient treatment, such as Rituximab and Alemtuzumab, can
interfere with recognition of target antigens by this reagent or deplete the clinically relevant cell
populations. This should be considered when analyzing samples from patients treated in this fashion.
BD Biosciences has not characterized the effect of the presence of therapeutic antibodies on the
performance of this reagent.

l Avoid using potentially compromised specimens, including clotted, hemolyzed, frozen, or refrigerated
specimens.

6. PROCEDURE

Reagents and Materials

Reagents and materials provided

The reagent tubes are provided as single-use tubes in foil pouches.

BD OneFlow™ PCST:

l Two pouches, each containing five tubes of BD OneFlow™ PCST (S) 
l Two pouches, each containing five tubes of BD OneFlow™ PCST (C)
BD OneFlow™ PCD:

l Two pouches, each containing five tubes of BD OneFlow™ PCD
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Reagents and materials required but not provided
l BD OneFlow™ Assays Installer I (Catalog No. 664225)

An installer is required to use the BD OneFlow™ reagents with BD FACSuite™ Clinical application. The
assays installer includes an acquisition sheet, a laboratory report, a physician report, and a supplemental
report used for sample analysis and results reporting. Unless you already have the current BD OneFlow™
Assays Installer, you will have to order the installer the first time you order the reagent.

The BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow Cytometers is
provided with the installer.

l BD OneFlow™ Assay Templates Installer (Catalog No. 659305)

An installer is required to use the BD OneFlow™ reagents with BD FACSDiva™ software. The templates
installer includes two global worksheets: the BD OneFlow™ Acquisition worksheet and the BD OneFlow™
Analysis worksheet. Unless you already have the current BD OneFlow™ Assay Templates Installer, you will
have to order the installer the first time you order the reagent. The installer also contains the OneFlow
Setup template.

The Instrument Setup Guide for BD OneFlow™ Assays and the BD OneFlow™ Application Guide for Plasma
Cell Disorders are provided with the installer.

l 15-mL conical polypropylene tubes
l 40-µm cell strainer, if needed
l Pasteur pipet
l Serological pipet
l Micropipettor with tips
l Vortex mixer
l Centrifuge
l Wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium azide)
l FIX&PERM® Cell Fixation and Permeabilization Kit
l (Optional) BD FACS™ Universal Loader
NOTE Labs must validate any deviations from the following procedures.

Installing the Assay or Template

The BD OneFlow™ Assay Installer, used with the BD FACSuite™ Clinical application, or the BD OneFlow™ Assay
Template Installer, used with BD FACSDiva™ software, has to be installed before you run the assay for the
first time. Additional assays or templates can be installed at the same time, as needed. If you will analyze the
FCS files on a different workstation from the one used to acquire the samples, ensure that you install the
assays or templates on both workstations.

To install the BD OneFlow™ assay in BD FACSuite™ Clinical application:

NOTE When you select an assay to install, it will overwrite the BD OneFlow™ assay that was previously
installed on the system. If you do not want an existing assay on your computer to be overwritten, do not
select that assay from the installer during the installation process.
1. Insert the installer and click the installer icon.

The InstallShield Wizard for BD OneFlow™ Assays opens.

2. Click Next.
The license agreement opens.

3. Select the I accept the terms in the license agreement option and click Next.
4. To install all of the assays included on the installer, select the Complete option and click Next.
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5. Optional: To install a subset of the assays included on the installer, select the Custom option and click
Next.

The Custom Setup dialog opens.

l Click the menu to the left of the appropriate assay.
l From the menu, select This assay will be installed on your local hard drive.

6. Click Install.
The assays will be installed in the Library.

7. Click Finish.
The InstallShield Wizard closes.

8. Optional: Double-click the ReadMe file found on the installer.
The ReadMe file opens.

9. Click the close box when finished reading it.
10. Remove the installer.
To install the OneFlow template in BD FACSDiva™ software:

NOTE When you select a template to install, it will always overwrite any template with the same name that
was previously installed on the system. If you do not want an existing template on your computer to be
overwritten, do not select that template from the installer during the installation process.
1. Insert the installer and click the installer icon.
2. Follow the instructions in the dialog.

The installer will copy and paste the templates in the folder D:\BDExport\Templates\Panel\BD Panels.

NOTE If your system has only one drive, the templates will be installed in
C:\BDExport\Templates\Panel\BD Panels.
After installation is complete, a dialog opens, summarizing which templates have been successfully copied
into the folder.

3. Click OK to close the dialog.
4. The installer ReadMe file opens. Click the close box when you have finished reading it.
5. Remove the installer.

Setting up the Cytometer

For BD FACSLyric™ flow cytometers:

1. Use BD® CS&T Beads and BD FACSuite™ Clinical application v1.4 or later, to perform Characterization QC
(CQC) every 6 months or as needed, perform daily Performance QC (PQC), and perform daily assay and
tube settings setup. For assay and tube settings setup, select the Run Setup and Generate Reports
checkboxes.

2. Use the BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD FACSuite™ Clinical application v1.4 or
later, to update reference settings every 60 days. In addition, use the BD® FC Beads 2-Color Kit to set up a
12-color instrument.
See the BD FACSLyric™ System Instructions For Use, the BD FACSLyric™ Clinical Reference System, and the
appropriate reagent IFU for more information.

For BD FACSCanto™ II flow cytometers:

1. Use BD FACSDiva™ CS&T IVD Beads (CS&T IVD beads) and BD FACSDiva™ software v8.0.1 or later, to
define the baseline of the cytometer and to run a daily performance check of the cytometer.

2. Use BD OneFlow™ Setup Beads, lysed washed blood, and BD FACSDiva™ software v8.0.1 or later, to set
photomultiplier tube (PMT) and scatter voltages monthly.

3. Use BD® FC Beads and BD FACSDiva™ software v8.0.1 or later, to set fluorescence compensation monthly.
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4. We recommend that you confirm that the PMT voltages (PMTVs) are still within their daily target ranges.
See the Instrument Setup Guide for BD OneFlow™ Assays and the appropriate reagent IFU for more
information.

Processing the Specimen

Washing the specimen

NOTE Before washing the specimen, confirm that the cytometer has been properly set up.
1. For each tube to be stained, label a 15-mL conical tube with the specimen ID.
2. Invert the specimen in the collection tube 10 times to mix well. Verify that the specimen is not lipemic and

does not have particulate matter in it.
3. If needed, pass sufficient specimen through a 40-µm cell strainer.
4. Add 300 µL of the specimen to the labeled conical tube.
5. Add 10 mL of wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium azide).
6. Invert the tube 3–5 times to mix well.
7. Centrifuge at 540g for 5 minutes at 20–25 °C.
8. Remove the supernatant without disturbing the cell pellet.

NOTE If the cell pellet is disturbed, centrifuge the tube again and then remove the supernatant without
disturbing the cell pellet.

9. Vortex the tube until no cell aggregates remain in the residual wash buffer.
10. Repeat steps 5–9 twice for a total of three washes.
11. Resuspend the cell pellet in wash buffer to give a final volume of 300 µL.
12. Vortex vigorously 3–5 seconds to completely resuspend the cell pellet.

NOTE Start staining the specimen within 30 minutes of the last wash. Store the washed specimen at
20–25 °C until you stain it.

Staining the specimen

1. If the pouch is stored refrigerated, allow it to reach room temperature before opening it.
NOTE The reagent is very sensitive to moisture. To avoid condensation, open the pouch only if it is at
room temperature.

2. For each patient specimen, remove a BD OneFlow™ PCST (S) tube and a BD OneFlow™ PCD tube from its
pouch and reseal the pouch immediately. Do not remove the BD OneFlow™ PCST (C) tube at this time.

3. Place the tubes in a rack, protected from light.
Start staining the specimen within one hour of removing a tube from the pouch.

4. Immediately reseal the pouch with any unused tubes.
NOTE Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch. Use the tubes within six months of
opening the pouch.

5. Write the patient ID on the tube label within the area provided.
6. Vortex washed specimen 3–5 seconds to mix well.
7. Add 50 µL of wash buffer and 50 µL of washed specimen to each tube. Vortex vigorously 3–5 seconds to

mix well.
NOTE Staining from 5 × 105 to 8 × 107 white blood cells/mL gives equivalent results.

8. Incubate for 30–35 minutes at 20–25 °C in the dark.
9. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix well.

10. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.
11. Centrifuge at 540g for 5 minutes at 20–25 °C.
12. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 µL of residual liquid

in the tube.
13. Vortex vigorously until the cell pellet is completely resuspended.
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14. Add 100 µL of FIX&PERM® Reagent A (fixation solution) to each tube. Vortex vigorously 3–5 seconds to
mix well.
NOTE The BD OneFlow™ PCD tube does not stain intracellular markers. However, it is critical to perform
the fixation and permeabilization steps to allow a direct comparison of the staining results with those
obtained using the BD OneFlow™ PCST tube.

15. Incubate for 15 minutes at 20–25 °C in the dark.
16. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix well.
17. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.
18. Centrifuge at 540g for 5 minutes at 20–25 °C.
19. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 µL of residual liquid

in the tube.
20. Vortex vigorously until the cell pellet is completely resuspended.

NOTE If the you are unable to obtain a single-cell suspension, see Troubleshooting.
21. Measure the volume in each tube using a pipet and add wash buffer to give a final volume of 100 µL in

each tube. Vortex 3–5 seconds to mix well.
NOTE It is important to have a final volume of 100 µL in each tube so that all of the cells will be
completely permeabilized in steps 24–27.

22. Remove the appropriate number of BD OneFlow™ PCST (C) tubes from the pouch and reseal the pouch
immediately.
CAUTION Ensure that the pouch is completely resealed after removing a tube. The reagent is very
sensitive to moisture. Do not remove the desiccant from the reagent pouch. Use the tubes within six
months of opening the pouch.

23. Write the patient ID on the BD OneFlow™ PCST (C) tube label within the area provided.
24. Add 100 µL of FIX&PERM® Reagent B (permeabilization solution) to the BD OneFlow™ PCST (C) tube and

to the BD OneFlow™ PCD tube.
25. Transfer 100 µL of the sample from the BD OneFlow™ PCST (S) tube to the corresponding BD OneFlow™

PCST (C) tube.
NOTE Make sure that the patient ID numbers on the two tubes are the same.

26. Vortex the tubes vigorously 3–5 seconds to mix well.
27. Incubate for 15 minutes at 20–25 °C in the dark.
28. Add 1.5 mL of wash buffer. Vortex vigorously 3–5 seconds to mix well.
29. Add an additional 1.5 mL of wash buffer. Vortex gently to mix.
30. Centrifuge at 540g for 5 minutes at 20–25 °C.
31. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 µL of residual liquid

in the tube.
32. Vortex 3–5 seconds to resuspend the cell pellet.
33. Add 250 µL of wash buffer to the tube to give a final volume of 300 μL. Vortex 3–5 seconds to mix well.

NOTE Samples should be acquired within 60 minutes of staining if kept at room temperature, protected
from light.

Setting up the Assay (BD FACSLyric™ Flow Cytometer)

To add a reagent lot ID and expiration date to the library:

1. From the BD FACSuite™ Clinical application navigation bar, click the Library icon.
The Library workspace opens.

2. Expand the Beads and Reagentsmenu and select Reagents.
3. Select the appropriate BD OneFlow™ reagent from the Product Name list.

The OneFlow reagent pane opens at the bottom of the page.

4. Click Add Lot.
The Add New Lot dialog opens.
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5. In BD FACSuite™ Clinical application v1.5, click Scan Barcode and then scan the barcode on the pouch or
tube label.
The Lot ID and expiration date are entered in the appropriate fields.

NOTE In BD FACSuite™ Clinical application v1.4, add the Lot ID and expiration date manually.
6. Select the Current Lot checkbox.
7. Click OK.

The lot ID and expiration date are added to the appropriate columns for the reagent.

NOTE Make sure to add the reagent lot and expiration date prior to acquisition. This has to be done only
once for a particular reagent lot.

To create a worklist:

1. From the BD FACSuite™ Clinical application navigation bar, click the Worklists icon.
The Worklists workspace opens.

2. In theManage Worklists tab, click New.
A blank worklist opens in a new tab.

3. In theWorklist Entries section, select the appropriate task from the Taskmenu.
4. Enter the Sample ID for BD OneFlow™ reagent tasks.

Do not scan the barcode, found on the tube label, into the software.

NOTE Multiple lots of the same reagent cannot be run on the same worklist.
5. In the Loading Options section, selectManual or Universal Loader from the Loading Optionmenu.
6. If using the Loader, select 30 Tube Rack or 40 Tube Rack from the Carrier Typemenu.

NOTE Confirm that the order of samples in the rack matches the order entered in the software when
setting up the Loader.
See the BD FACSLyric™ System Instructions For Use for more information.

Setting up the Experiment (BD FACSCanto™ II Flow Cytometer)
1. From the menu bar, select Edit > User Preferences, then navigate to the FCS tab, and select Export FCS

after recording, to automatically export the FCS files after acquisition. Click OK.
2. Confirm that the cytometer is in the default 4-2H-2V configuration.
3. From the menu bar, select Experiment > New Experiment > Blank Experiment. Click OK.

NOTE You can also create an experiment directly from the Browser using the Experiment icon.
4. If prompted by the CST Mismatch window, select Use CST Settings.
5. Rename the experiment according to your laboratory practice.
6. In the Browser, right-click Cytometer Settings > Link Setup and select the appropriate compensation

matrix calculated using BD® FC Beads within the past 31 days. Click Link.
See the BD® FC Beads 8-Color Kit for BD OneFlow™ Assays IFU or the Instrument Setup Guide for
BD OneFlow™ Assays.

7. If prompted by the Cytometer Settings Mismatch window, select Overwrite.
8. Right-click Cytometer Settings > Unlink From and select the previously linked compensation setup. Click

OK.
NOTE Unlinking the compensation setup allows updated application settings to be applied while
retaining compensation values.

9. In the Browser, right-click Cytometer Settings > Application Settings > Apply and select the most recent
application settings determined within the last 31 days using the BD OneFlow™ Setup Beads. Click Apply.

10. A Confirm dialog opens. Select Keep the compensation value.
11. If prompted by the Confirm Cytometer Changes dialog, click Yes to overwrite the cytometer values for

FSC Area Scaling.
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12. From the menu bar, select Experiment > New Specimen.
The Panel Templates dialog opens.

13. Navigate to the BD Panels tab and select the appropriate OneFlow template.
14. Indicate the number of patient specimens you want to acquire using the Copies field near the bottom of

the BD Panels tab. Click OK.
15. Rename each specimen, for example, with the appropriate patient ID in front of the specimen name.

NOTE If you have to re-run a particular patient sample, set the current tube pointer to the tube you wish
to re-run. Click Next Tube in the Acquisition Dashboard to create another tube for that patient. Do not
select Experiment > New Tube from the menu bar or use the New Tube icon from the Browsermenu bar
to create the additional tube to be acquired because the labels and barcode fields will not be populated.
NOTE If you want to acquire additional patient samples stained with the BD OneFlow™ reagent in the
experiment, repeat steps 12–15 to add new specimens. Two Confirm dialogs will open asking if you want
to create another acquisition worksheet or another analysis worksheet. Click Cancel in each dialog.

16. From the menu bar, select Experiment > Experiment Layout and navigate to the Keywords tab.
17. Highlight the Product ID keyword for the appropriate tube, and scan the barcode on the BD OneFlow™

tube label.
NOTE If you cannot scan the barcode on the tube label, see Troubleshooting.

18. Manually add the appropriate information to the remaining keywords, as needed.
19. Click OK to close the Experiment Layout.

Acquiring the Stained Sample

For BD FACSLyric™ flow cytometers:

Two versions of the assay are available:

Assay version Software Stopping time Acquisition mode

v1.0 BD FACSuite™ Clinical application v1.4 or later 5 minutes Manual

v1.1 BD FACSuite™ Clinical application v1.5 or later 3 minutes Manual, Loader

The assay will automatically collect 100,000 total events. You cannot append the number of events to collect
after acquisition has started. Therefore, if needed, change the number of events to collect before you start
acquisition. To change the number of events to collect, see the BD OneFlow™ Application Guide for Plasma
Cell Disorders for BD FACSLyric™ Flow Cytometers. A clinically relevant number of cells can be determined at
the discretion of an appropriate healthcare professional.

To acquire the sample using the BD OneFlow™ assay v1.1:

1. In theWorklist Controls bar, select Run All from the Runmenu to run the entire worklist from the
beginning.
Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Runmenu.

2. Vortex each stained tube 3–5 seconds at low speed immediately prior to acquisition.
If using the BD FACS™ Universal Loader, vortex tubes immediately before placing them in the Loader
racks.

NOTE Make sure that all of the BD OneFlow™ tubes in the rack are acquired within 1 hour. If not, you
must validate tubes acquired outside the 1 hour time.
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3. Follow the prompts in the software to load or unload tubes.
The BD OneFlow™ Acquisition sheet opens. The acquisition sheet contains dot plots and gates to identify
Leukocytes, Lymphocytes, and the relevant cell populations for the assay.

4. Examine each dot plot on the acquisition sheet.
NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.
NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000 total
events, acquisition will stop after 3 minutes. A QC message, “All Events gate does not contain the
requested 100,000 events” is generated in the Lab Report, and can be ignored if the sample can be
analyzed using the events acquired.
See the BD FACSLyric™ System Instructions For Use for more information.

To acquire the sample using the BD OneFlow™ assay v1.0:

1. In theWorklist Controls bar, select Run All from the Runmenu to run the entire worklist from the
beginning.
Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Runmenu.

2. Vortex each stained tube 3–5 seconds at low speed immediately prior to acquisition.
3. Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ Acquisition sheet opens. The acquisition sheet contains dot plots and gates to identify
Leukocytes, Lymphocytes, and the relevant cell populations for the assay.

4. Examine each dot plot on the acquisition sheet.
NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.

5. If it appears that fewer than 100,000 events will be collected, monitor the sample volume and click Stop
Tube in theWorklist Controls bar to stop acquisition before the tube runs dry.
NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000 total
events, acquisition will stop after 5 minutes. However, make sure you monitor the sample volume and click
Stop Tube in theWorklist Controls bar to stop acquisition before the tube runs dry. To change the
stopping criteria, see the BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow
Cytometers.
See the BD FACSLyric™ System Instructions For Use for more information.

For BD FACSCanto™ II flow cytometers:

1. In the Browser, expand the appropriate specimen and set the current tube pointer to that tube.
2. Select the appropriate BD OneFlow™ Acquisition worksheet tab.
3. Vortex the stained tube 3–5 seconds at low speed.
4. Install the tube on the cytometer. Adjust the flow rate toMedium in the Acquisition Dashboard. Click

Acquire Data.
5. Verify that the population is on scale and adjust the gate in the first plot of the acquisition worksheet to

exclude debris, if needed.
6. Click Record Data in the Acquisition Dashboard to collect total events.

NOTE The template will automatically collect 100,000 total events. Use the menu in the Acquisition
Dashboard to select a different number of events to acquire, if needed. A clinically relevant number of
cells can be determined at the discretion of an appropriate healthcare professional.
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7. Inspect the dot plots on the acquisition worksheet and adjust the gates as needed.
Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The FSC-A vs SSC-A dot plot is used to identify cells.

The remaining dot plots either contain gates to identify the relevant cell populations for the assay, or do
not contain gates and are included to ensure that the antibodies can stain cells in the specimen, therefore
serving as an internal quality control for the tube.

NOTE See the appropriate BD OneFlow™ Application Guide for examples of the dot plots showing
populations of normal cells in the acquisition worksheet.

8. Acquire the next sample.
9. From the menu bar, select File > Export > Experiments, and select the Directory Export option. Click OK.

Analyzing the Data Using BD FACSuite™ Clinical Application

NOTE FCS files acquired using BD OneFlow™ assay v1.0 can be opened in BD OneFlow™ assay v1.1.
To analyze a sample stained using BD OneFlow™ PCST:

1. Set the run pointer to the appropriate sample in theWorklist Entries panel.
The BD OneFlow™ PCST Laboratory Report opens in the Laboratory Report tab.

2. Review the BD OneFlow™ PCST Laboratory Report.
The first page of the laboratory report shows sample and tube information, population statistics, and QC
messages, if generated.

NOTE Populations with a low number of events might report %Parent or %Grandparent as 0.0%. This is
due to rounding the result to a single decimal place in BD FACSuite™ Clinical application.

3. Inspect the dot plots on page 2 of the laboratory report and adjust the gates as needed.
The dot plots on page 2 of the laboratory report provide a high level cell analysis, identifying Cells, FSC
Singlets, SSC Singlets, and B cells.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size. Use the CD45 V500-C-A vs SSC-
A density plot when adjusting the Leukocytes and Lymphocytes gates.
See the BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow Cytometers for
examples of dot plots showing populations of normal cells.

4. Inspect the dot plots on page 3 of the laboratory report and adjust the gates as needed.
The dot plots on page 3 of the laboratory report are used to analyze the plasma cells in the sample. Dot
plots and gates are provided to identify CD38+ cells, Plasma cells, cyIgL+, and cyIgK+ cells. The remaining
dot plots characterize the cyIgL+ and cyIgK+ populations.

5. Inspect page 4 of the laboratory report.
Page 4 of the laboratory report includes lot and expiration dates for BD® CS&T Beads and the
BD OneFlow™ reagent, reference settings, tube settings, and cytometer configuration.

6. (Optional) Select the Physician Report tab to view the report.
The BD OneFlow™ PCST Physician Report contains a high level summary of the assay results.
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7. (Optional) Select the Supplemental Report tab to add additional dot plots to further analyze the sample.
See the BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow Cytometers for
more information.

WARNING Any gated regions deleted in this Supplemental Report are reflected in the Laboratory and
Physician Reports. Any gated regions created in this Supplemental Report might be reflected in the
Laboratory Report.

WARNING Do not add dot plots or gates to the Laboratory Report or Physician Report. They cannot be
deleted and will invalidate the report.

8. Select the Laboratory Report tab.
9. Click E-sign.

The E-Signature dialog opens.
10. Select a user ID.
11. Type your password.
12. (Optional) Enter any comments.
13. Click Sign.

The signer’s user ID, date and time, and comments are added to the E-signature box in all three reports.
14. Click Approve.

The Laboratory and Physicians Reports are automatically exported to C:\BD Export Clinical. If needed,
manually export the Supplemental Report.
See the BD FACSLyric™ System Instructions For Use for more information and export options.

To analyze a sample stained using BD OneFlow™ PCD:

1. Set the run pointer to the appropriate sample in theWorklist Entries panel.
The BD OneFlow™ PCD Laboratory Report opens in the Laboratory Report tab.

2. Review the BD OneFlow™ PCD Laboratory Report.
The first page of the laboratory report shows sample and tube information, population statistics, and QC
messages, if generated.

NOTE Populations with a low number of events might report %Parent or %Grandparent as 0.0%. This is
due to rounding the result to a single decimal place in BD FACSuite™ Clinical application.

3. Inspect the dot plots on page 2 of the laboratory report and adjust the gates as needed.
The dot plots on page 2 of the laboratory report provide a high level cell analysis, identifying Cells, FSC
Singlets, SSC Singlets, CD38+ cells, Plasma cells, and B cells.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size. Use the CD45 V500-C-A vs SSC-
A density plot when adjusting the Leukocytes and Lymphocytes gates.
See the BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow Cytometers for
examples of dot plots showing populations of normal cells.

4. Inspect the dot plots on page 3 of the laboratory report and adjust the gates as needed.
The dot plots on page 3 of the laboratory report are used to analyze the plasma cells in the sample. Dot
plots and gates are provided to identify CD38+ cells, and Plasma cells. The remaining dot plots
characterize the plasma cells in the sample.

5. Inspect page 4 of the laboratory report.
Page 4 of the laboratory report includes lot and expiration dates for BD® CS&T Beads and the
BD OneFlow™ reagent, reference settings, tube settings, and cytometer configuration.
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6. (Optional) Select the Physician Report tab to view the report.
The BD OneFlow™ PCD Physician Report contains a high level summary of the assay results.

7. (Optional) Select the Supplemental Report tab to add additional dot plots to further analyze the sample.
See the BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow Cytometers for
more information.

WARNING Any gated regions deleted in this Supplemental Report are reflected in the Laboratory and
Physician Reports. Any gated regions created in this Supplemental Report might be reflected in the
Laboratory Report.

WARNING Do not add dot plots or gates to the Laboratory Report or Physician Report. They cannot be
deleted and will invalidate the report.

8. Select the Laboratory Report tab.
9. Click E-sign.

The E-Signature dialog opens.
10. Select a user ID.
11. Type your password.
12. (Optional) Enter any comments.
13. Click Sign.

The signer’s user ID, date and time, and comments are added to the E-signature box in all three reports.
14. Click Approve.

The Laboratory and Physicians Reports are automatically exported to C:\BD Export Clinical. If needed,
manually export the Supplemental Report.
See the BD FACSLyric™ System Instructions For Use for more information and export options.

Analyzing the Data Using BD FACSDiva™ Software

To analyze a sample stained using BD OneFlow™ PCST:

1. From the menu bar, select File > Import > Experiments.
2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis worksheets opens.

3. Select the BD OneFlow™ PCST Analysis worksheet tab.
4. Inspect the dot plots on page 1 of the analysis worksheet, and adjust the gates as needed.

Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris might appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The first three dot plots on page 1 of the analysis worksheet identify the FSC and SSC singlets. Debris and
doublets are excluded by adjusting the gates.

The CD38+ cells are identified in the CD38 FITC-A vs CD45 V450-A dot plot, and then plasma cells are
identified in the CD38 FITC-A vs CD138 V500-A dot plot. The plasma cells are subsequently characterized
by gating on the cells expressing cyIgκ and cyIgλ. These three dot plots are repeated at the top of page 2
of the PCST analysis worksheet for reference. The CD38 FITC-A vs SSC-A dot plot is included for
informational purposes to allow for the visualization of CD38bright cells.
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B cells are identified in the CD19 PE-Cy7-A vs SSC-A dot plot and then characterized in the cyIgK APC-A vs
cyIgL APC-H7-A dot plot.

NOTE See the BD OneFlow™ Application Guide for Plasma Cell Disorders for examples of dot plots
showing populations of normal cells.

5. Inspect the dot plots on page 2 of the analysis worksheet.
The cyIgκ+ plasma cells and cyIgλ+ plasma cells are further characterized according to the levels of CD19,
CD45, CD56, and β2-Microglobulin expression.

6. Examine the results in the statistics box on page 3 of the analysis worksheet.
Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see
Troubleshooting.

7. Perform further analyses as needed.
NOTE The gates provided in the dot plots of the analysis worksheet are for normal populations of cells. If
your analysis shows cell populations which fall outside of the provided gates, they might represent
aberrant cell populations, and will require further analysis.

8. Save the BD OneFlow™ PCST analysis worksheet as a PDF.
NOTE The BD OneFlow™ PCST analysis worksheet is a global worksheet. Any gates that are adjusted
when analyzing a sample on a global worksheet will be changed in previously analyzed files. Previously
saved PDFs will not change, but if you go back to a previously analyzed global worksheet, you will have to
readjust the gates so they match what they were before.

9. (Optional) Click Print to print the analysis worksheet as a PDF.
10. Analyze the next sample.

To analyze a sample stained using BD OneFlow™ PCD:
1. From the menu bar, select File > Import > Experiments.
2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis worksheets opens.

3. Select the BD OneFlow™ PCD Analysis worksheet tab.
4. Inspect the plots on page 1 of the analysis worksheet, and adjust the gates as needed.

Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The first three dot plots on page 1 of the analysis worksheet identify the FSC and SSC singlets. Debris and
doublets are excluded by adjusting the gates.

The CD38+ cells are identified in the CD38 FITC-A vs CD45 V450-A dot plot, and then plasma cells are
identified in the CD38 FITC-A vs CD138 V500-A dot plot. These two dot plots are repeated at the top of
page 2 of the analysis worksheet for reference. The CD38 FITC-A vs SSC-A dot plot is included for
informational purposes to allow for the visualization of CD38bright cells.

B cells are identified in the CD19 PE-Cy7-A vs SSC-A dot plot.

NOTE See the BD OneFlow™ Application Guide for Plasma Cell Disorders for examples of dot plots
showing populations of normal cells.
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5. Inspect the dot plots on page 2 of the analysis worksheet.
The dot plots on page 2 of the analysis worksheet include markers that can help characterize the plasma
cells as being normal or aberrant.

6. Examine the results in the statistics box on page 3 of the analysis worksheet.
Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see
Troubleshooting.

7. Perform further analyses as needed.
NOTE The gates provided in the dot plots of the PCD analysis worksheet are for normal populations of
cells. If your analysis shows cell populations which fall outside of the provided gates, they might represent
aberrant cell populations, and will require further analysis.

8. Save the BD OneFlow™ PCD analysis worksheet as a PDF.
NOTE The BD OneFlow™ PCD analysis worksheet is a global worksheet. Any gates that are adjusted when
analyzing a sample on a global worksheet will be changed in previously analyzed files. Previously saved
PDFs will not change, but if you go back to a previously analyzed global worksheet, you will have to
readjust the gates so they match what they were before.

9. (Optional) Click Print to print the analysis worksheet.
10. Analyze the next sample.

7. RESULTS

Representative Data

See the appropriate application guide to see laboratory reports showing dot plots from a hematologically
normal adult sample stained with each reagent.

For BD FACSLyric™ flow cytometers:

l BD OneFlow™ Application Guide for Plasma Cell Disorders for BD FACSLyric™ Flow Cytometers
For BD FACSCanto™ II flow cytometers:

l BD OneFlow™ Application Guide for Plasma Cell Disorders

8. LIMITATIONS
l Use of this reagent for diagnostic evaluation of hematologic disorders should be performed in the context

of a thorough immunophenotypic analysis including other relevant markers.
l Use of the BD OneFlow™ Plasma Cell Disorders Panel requires experience with leukemia and lymphoma

immunophenotyping and classification. The results should be interpreted by a pathologist, or equivalent
professional, in conjunction with other clinical or laboratory findings.

l The BD OneFlow™ Plasma Cell Disorders Panel has not been tested on specimens from patients with
minimal residual disease (MRD).

9. PERFORMANCE CHARACTERISTICS

Specimen handling and collection (AOB/AOS)

A study was performed to assess the Age of Blood (AOB) and Age of Stain (AOS) using BD OneFlow™ PCST
and BD OneFlow™ PCD. The stability of EDTA- or heparin-anticoagulated bone marrow specimens was
evaluated by assessing the combined effect of:

l AOB: Time duration between specimen collection and staining
l AOS: Time duration between completion of stained sample processing and acquisition with the flow

cytometer.
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Specimens were tested up to 28 hours post collection and stained samples were tested up to 80 minutes post
stain. All samples were maintained at room temperature before staining or acquisition.

Based on the results of this study, we recommend staining samples within 24 hours of collection and
acquiring samples within 1 hour of staining if the sample is kept at 20–25 °C.

BD FACSLyric™ Flow Cytometer (BD OneFlow™ PCST)

Method comparison, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer
(BD OneFlow™ PCST)

A method comparison study between the BD OneFlow™ system on the BD FACSLyric™ flow cytometer
(Investigational Method) and the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
(Comparator Method) was performed at 4 clinical sites. The BD OneFlow™ system on BD FACSLyric™
comprises BD® CS&T Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD OneFlow™ PCST
acquired on a 10-color BD FACSLyric™ flow cytometer (4-Blue 3-Red 3-Violet) using BD FACSuite™ Clinical
application v1.3 and the BD OneFlow™ PCST assay. (A regression study was performed, demonstrating
equivalence between BD FACSuite™ Clinical application v1.3 and v1.4.) The BD OneFlow™ reference system
on BD FACSCanto™ II comprises BD FACSDiva™ CS&T IVD Beads, BD OneFlow™ Setup Beads, BD® FC Beads
8-Color Kit for BD OneFlow™ Assays, and BD OneFlow™ PCST acquired on a BD FACSCanto™ II flow cytometer
(4-2H-2V) using BD FACSDiva™ software v8.0.2 and the BD OneFlow™ PCST template. A total of 80 evaluable
BM specimens were enrolled in the study. Specimens were collected in the anticoagulants shown. See the
following table.

Specimen type

Anticoagulant

EDTA Heparin

Abnormal plasma cells 41 1

Normal polyclonal plasma cells 35 3

Total 76 4

Table 3 Anticoagulants used to collect specimens

For all enrolled specimens, the first wash step was started within 24 hours of collection. All stained samples
were acquired within 45 minutes of final resuspension. For all enrolled specimens, the number of plasma cell
events and percentages were within the ranges shown. See the following table.

Plasma cells Range

Number of events 12–38,065

% of SSC Singlets 0–42.4%

Table 4 Ranges of plasma cell events and percentages

Specimens were identified as “Aberrant plasma cells” or “Normal polyclonal plasma cells” using the two
systems, and compared.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100

Positive % agreement = (a/(a+c))×100

Negative % agreement = (d/(d+b))×100

wherein,
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a = number of samples identified as “Aberrant plasma cells” for both systems,

b = number of samples identified as “Aberrant plasma cells” on the BD FACSLyric™ flow cytometer but “Normal polyclonal plasma cells”
on the BD FACSCanto™ II flow cytometer,

c = number of samples identified as “Normal polyclonal plasma cells” on the BD FACSLyric™ flow cytometer but “Aberrant plasma cells”
on the BD FACSCanto™ II flow cytometer,

d = number of samples identified as “Normal polyclonal plasma cells” for both systems.

The results for the identification of specimens as “Aberrant plasma cells” or “Normal polyclonal plasma cells”
were tabulated. See the following table.

Comparator method (BD FACSCanto™ II)

Aberrant plasma
cells

Normal polyclonal
plasma cells

Total

Investigational method
(BD FACSLyric™)

Aberrant plasma cells 42 0 42

Normal polyclonal
plasma cells

0 38 38

Total 42 38 80

Table 5 Agreement for specimens identified as “Aberrant plasma cells” or “Normal polyclonal plasma cells”

Overall % agreement is 100%. The lower 95% confidence limit is 96.32%.

Positive agreement for “Aberrant plasma cells” is 100%. Negative agreement for “Normal polyclonal plasma
cells” is 100%.

Equivalency (BD FACSLyric™ flow cytometer)

A quantitative assessment of the cell populations being a percentage of the indicated cell population was
performed for each evaluable specimen enrolled in the method comparison study. Specimens were analyzed
using the BD OneFlow™ system on the BD FACSLyric™ flow cytometer and the BD FACSCanto™ II flow
cytometer as described previously.

The mean bias for each cell population being a percentage of the indicated population on the BD FACSLyric™
flow cytometer versus the BD FACSCanto™ II flow cytometer was calculated for all evaluable specimens. See
the following table.

Population No. of specimensa Mean bias Lower 95% CL
of mean bias

Upper 95% CL
of mean bias

Plasma cells (%SSC singlets) 80 –0.04 –0.14 0.06

cyIgKappa (%Plasma cells) 80 –2.03 –3.37 –0.69

cyIgLambda (%Plasma cells) 80 –0.55 –1.71 0.62

a. Some specimens might have been excluded to a low number of events acquired.

Table 6 Summary of mean bias for subset percentages

The results of the method comparison and equivalency studies indicate that the two systems are substantially
equivalent.

18



Method comparison, BD FACS™ Universal Loader vs manual acquisition
(BD OneFlow™ PCST)

A study was performed at one site to demonstrate equivalency between acquisition using the
BD FACS™ Universal Loader and manual acquisition. Bone marrow specimens from normal and abnormal
subjects were stained using a minimum of 3 lots of BD OneFlow™ PCST. For each specimen, 10 stained
replicates were acquired either manually or using the BD FACS™ Universal Loader (using the 30-tube and
40-tube racks).

The mean, absolute bias, and 95% confidence interval (CI) for acquisition using the
BD FACS™ Universal Loader vs manual acquisition were determined for the indicated populations. See the
following table.

Cell Population N

Mean Absolute % bias
(95% CI)Loader Manual

CD38+ cells (%SSC singlets) 20 6.20 6.30 –0.10
(–0.33, 0.13)

Plasma cells (%SSC singlets) 20 6.50 7.00 –0.50
(–1.10, 0.11)

cyIgk+ Plasma cells (%Plasma cells) 20 54.11 54.29 –0.18
(–1.37, 1.00)

cyIgl+ Plasma cells (%Plasma cells) 20 24.73 24.37 0.36
(–0.47, 1.18)

B cells (%SSC singlets) 20 3.07 3.02 0.05
(–0.03, 0.12)

Table 7 BD FACS™ Universal Loader vs manual acquisition for BD OneFlow™ PCST

The results were also assessed qualitatively by a flow cytometry expert for concordance between samples
acquired manually and samples acquired using the Loader. All samples stained with BD OneFlow™ PCST
showed 100% agreement.

Precision (within-site, control material) (BD OneFlow™ PCST)

A 21-day single-site precision study was performed to assess the within-site precision (repeatability and
reproducibility) of BD OneFlow™ PCST using control material. Estimates of precision were determined across
three BD FACSLyric™ flow cytometers and a minimum of three operators by acquiring CD-Chex CD103 Plus®

or BD Multi-Check™ Control supplemented with CD-Chex CD117® Plus, stained in duplicate by each operator
using three lots of BD OneFlow™ PCST. Two separate runs were performed by each operator on each of the
21 tested days.

Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, between operators, between lots,
and between instruments) were estimated. A total of 828 samples were analyzed. The mean, standard
deviation (SD), and coefficient of variation (%CV) is presented for each population. In addition, the one-sided
95% confidence limit (Upper SD or Upper %CV) for the total system precision was calculated.
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Population
(% of positive) Mean

Repeatability Reproducibility Total precision

SD %CV SD %CV Upper SD Upper %CV

CD38+ 41.84 0.66 1.58 0.97 0.02 1.73 4.14

CD138+ 99.83 0.03 0.03 0.06 0.00 0.09 0.09

CD45+ 33.22 0.48 1.43 1.12 0.03 1.40 4.21

B cells 14.03 0.24 1.69 0.35 0.03 0.66 4.73

CD56+ 4.59 0.30 6.45 0.33 0.07 0.63 13.76

Igκ+ 59.33 1.21 2.04 1.86 0.03 3.53 5.94

Igλ+ 40.27 1.16 2.89 1.86 0.05 3.61 8.97

b2M+ 97.46 0.41 0.42 0.65 0.01 1.09 1.12

Table 8 Summary of within-site precision of subset percentages for BD OneFlow™ PCST

Precision (multi-site, control material) (BD OneFlow™ PCST)

Multi-site precision was evaluated across three sites using one lot of BD OneFlow™ PCST to stain three
replicates of CD-Chex CD103 Plus® or BD Multi-Check™ Control supplemented with CD-Chex CD117® Plus.
Two runs per day were acquired on a BD FACSLyric™ flow cytometer by one operator per site over a period of
5 days.

Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, and between sites) were
estimated. The mean, standard deviation (SD), and coefficient of variation (%CV) is presented for each
population. A total of 90 samples were analyzed. In addition, the one-sided 95% confidence limit (Upper SD
or Upper %CV) for the total system precision was calculated.

Population
(% of positive) Mean

Repeatability Reproducibility Total precision

SD %CV SD %CV Upper SD Upper %CV

CD38+ 41.88 0.57 1.37 1.15 0.03 2.30 5.50

CD138+ 99.78 0.06 0.06 0.06 0.00 0.12 0.12

CD45+ 33.12 0.56 1.68 1.27 0.04 1.89 5.69

B cells 14.31 0.30 2.13 0.20 0.01 0.44 3.05

CD56+ 4.84 0.27 5.63 0.18 0.04 0.38 7.79

Igκ+ 57.86 1.62 2.80 1.33 0.02 2.48 4.29

Igλ+ 41.77 1.56 3.73 1.06 0.03 2.19 5.25

b2M+ 97.00 0.33 0.34 0.58 0.01 1.02 1.05

Table 9 Summary of multi-site precision of subset percentages for BD OneFlow™ PCST

Detection capability (BD OneFlow™ PCST)

The detection capability of BD OneFlow™ PCST was assessed. An abnormal specimen was added to a
hematologically normal bone marrow specimen such that the abnormal population was at 0%, 0.05%, or 0.1%
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of all events of the normal specimen. Two sets of abnormal and normal specimens and 2 lots of
BD OneFlow™ PCST were evaluated in the study.

Target population

Expected %
abnormal

cells Na

Number
disease
samples

Mean actual %
abnormal cells
(95% CIb)

SD of bias
(Upper 95% CI)

Trueness (95%
lower bound)

CD45 heterogeneous
CD38+

CD138+

IgK+

0.000 20 0 0.004
(0.003, 0.004)

N/Ac N/A

0.050 20 20 0.038
(0.033, 0.042)

0.0093
(0.0174)

100
(88.1)

0.100 20 20 0.081
(0.075, 0.087)

0.0127
(0.0238)

100
(88.1)

a. N = Number of replicates

b. CI = Confidence interval

c. N/A = Not applicable

Table 10 Detection capability of BD OneFlow™ PCST

Based on the results, a detection capability of 0.1% of all events is recommended for BD OneFlow™ PCST.

BD FACSLyric™ Flow Cytometer (BD OneFlow™ PCD)

Method comparison, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer
(BD OneFlow™ PCD)

A method comparison study between the BD OneFlow™ system on the BD FACSLyric™ flow cytometer
(Investigational Method) and the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
(Comparator Method) was performed at 4 clinical sites. The BD OneFlow™ system on BD FACSLyric™
comprises BD® CS&T Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD OneFlow™ PCD
acquired on a 10-color BD FACSLyric™ flow cytometer (4-Blue 3-Red 3-Violet) using BD FACSuite™ Clinical
application v1.3 and the BD OneFlow™ PCD assay. (A regression study was performed, demonstrating
equivalence between BD FACSuite™ Clinical application v1.3 and v1.4.) The BD OneFlow™ reference system
on BD FACSCanto™ II comprises BD FACSDiva™ CS&T IVD Beads, BD OneFlow™ Setup Beads, BD® FC Beads
8-Color Kit for BD OneFlow™ Assays, and BD OneFlow™ PCD acquired on a BD FACSCanto™ II flow cytometer
(4-2H-2V) using BD FACSDiva™ software v8.0.2 and the BD OneFlow™ PCD template. A total of 78 evaluable
BM specimens were enrolled in the study. Specimens were collected in the anticoagulants shown. See the
following table.

Specimen type Anticoagulant

EDTA Heparin

Presence of aberrant plasma cells 41 1

Absence of aberrant plasma cells 33 3

Total 74 4

Table 11 Anticoagulants used to collect specimens

For all enrolled specimens, the first wash step was started within 24 hours of collection. All stained samples
were acquired within 45 minutes of final resuspension. For all enrolled specimens, the number of plasma cell
events and percentages were within the ranges shown. See the following table.
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Plasma cells Range

Number of events 19–38,065

% of SSC Singlets 0–41.9%

Table 12 Ranges of plasma cell events and percentages

All evaluable specimens were characterized as containing aberrant plasma cells (“Presence of aberrant
plasma cells”) or lacking aberrant plasma cells (“Absence of aberrant plasma cells”) using the two systems,
and compared.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100

Positive % agreement = (a/(a+c))×100

Negative % agreement = (d/(d+b))×100

wherein,

a = number of samples characterized as “Presence of aberrant plasma cells” for both systems,

b = number of samples characterized as “Presence of aberrant plasma cells” on the BD FACSLyric™ flow cytometer but characterized as
“Absence of aberrant plasma cells” on the BD FACSCanto™ II flow cytometer,

c = number of samples characterized as “Absence of aberrant plasma cells” on the BD FACSLyric™ flow cytometer but characterized as
“Presence of aberrant plasma cells” on the BD FACSCanto™ II flow cytometer,

d = number of samples characterized as “Absence of aberrant plasma cells” for both systems.

The results for the identification of specimens as “Presence of aberrant plasma cells” versus “Absence of
aberrant plasma cells” were tabulated. See the following table.

Comparator method (BD FACSCanto™ II)

Presence of aberrant
plasma cells

Absence of aberrant
plasma cells

Total

Investigational method
(BD FACSLyric™)

Presence of aberrant
plasma cells

42 0 42

Absence of aberrant
plasma cells

0 36 36

Total 42 36 78

Table 13 Agreement for identification of specimens as “Presence of aberrant plasma cells” or
“Absence of aberrant plasma cells”

Overall % agreement is 100%. The lower 95% confidence limit is 96.23%.

The positive agreement for the presence of aberrant plasma cells is 100%. The negative agreement for the
absence of aberrant plasma cells is 100%.

Equivalency (BD OneFlow™ PCD)

A quantitative assessment of the cell populations being a percentage of the indicated cell population was
performed for each evaluable specimen enrolled in the method comparison study. Specimens were analyzed
using the BD OneFlow™ system on the BD FACSLyric™ flow cytometer and the BD FACSCanto™ II flow
cytometer as described previously.
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The mean bias for the plasma cell population being a percentage of the SSC singlets on the BD FACSLyric™
flow cytometer versus the BD FACSCanto™ II flow cytometer was calculated for all evaluable specimens. See
the following table.

Population No. of specimensa Mean bias Lower 95% CL
of mean bias

Upper 95% CL
of mean bias

Plasma cells (%SSC singlets) 78 0.19 –0.1 0.48

a. Some specimens might have been excluded due to a low number of events acquired.

Table 14 Summary of mean bias for subset percentages

The results of the method comparison and equivalency studies indicate that the two systems are substantially
equivalent.

Method comparison, BD FACS™ Universal Loader vs manual acquisition
(BD OneFlow™ PCD)

A study was performed at one site to demonstrate equivalency between acquisition using the
BD FACS™ Universal Loader and manual acquisition. Bone marrow specimens from normal and abnormal
subjects were stained using a minimum of 3 lots of BD OneFlow™ PCD. For each specimen, 10 stained
replicates were acquired either manually or using the BD FACS™ Universal Loader (using the 30-tube and
40-tube racks).

The mean, absolute bias, and 95% confidence interval (CI) for acquisition using the
BD FACS™ Universal Loader vs manual acquisition were determined for the indicated populations. See the
following table.

Population N

Mean Absolute % bias
(95% CI)Loader Manual

CD38+ cells (%SSC singlets) 20 6.14 6.06 0.08
(–0.10, 0.25)

Plasma cells (%SSC singlets) 20 5.10 5.28 –0.18
(–0.51, 0.15)

B cells (%SSC singlets) 20 2.84 2.87 –0.03
(–0.14, 0.08)

Table 15 BD FACS™ Universal Loader vs manual acquisition for BD OneFlow™ PCD

The results were also assessed qualitatively by a flow cytometry expert for concordance between samples
acquired manually and samples acquired using the Loader. All samples stained with BD OneFlow™ PCD
showed 100% agreement.

Precision (within-site, control material) (BD OneFlow™ PCD)

A 21-day single-site precision study was performed to assess the within-site precision (repeatability and
reproducibility) of BD OneFlow™ PCD using control material. Estimates of precision were determined across
three BD FACSLyric™ flow cytometers and a minimum of three operators by acquiring CD-Chex CD103 Plus®

or BD Multi-Check™ Control supplemented with CD-Chex CD117® Plus, stained in duplicate by each operator
using three lots of BD OneFlow™ PCD. Two separate runs were performed by each operator on each of the
21 tested days.
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Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, between operators, between lots,
and between instruments) were estimated. A total of 792 samples were analyzed for most populations. A
total of 828 samples were analyzed for CD38+ and CD38+CD138+ cells. The mean, standard deviation (SD),
and coefficient of variation (%CV) is presented for each population. In addition, the one-sided 95%
confidence limit (Upper SD or Upper %CV) for the total system precision was calculated.

Population
(% of positive) Mean

Repeatability Reproducibility Total precision

SD %CV SD %CV Upper SD Upper %CV

CD27+ 20.03 0.38 1.89 0.59 0.03 0.81 4.03

CD19+ 13.98 0.25 1.76 0.30 0.02 0.63 4.50

CD117+ 4.55 0.13 2.92 0.56 0.12 0.69 15.13

CD81+ 98.35 0.21 0.21 1.02 0.01 3.02 3.07

CD28+ 63.32 0.40 0.64 1.64 0.03 5.20 8.21

CD45+ 31.56 0.56 1.79 0.99 0.03 1.78 5.63

CD38+ 98.96 0.22 0.22 0.77 0.01 1.23 1.25

CD38+CD138+ 99.28 0.15 0.15 0.21 0.00 0.29 0.29

Table 16 Summary of within-site precision of subset percentages for BD OneFlow™ PCD

Precision (multi-site, control material) (BD OneFlow™ PCD)

Multi-site precision was evaluated across three sites using one lot of BD OneFlow™ PCD to stain three
replicates of CD-Chex CD103 Plus® or BD Multi-Check™ Control supplemented with CD-Chex CD117® Plus.
Two runs per day were acquired on a BD FACSLyric™ flow cytometer by one operator per site over a period of
5 days.

Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, and between sites) were
estimated. A total of 90 samples were analyzed.The mean, standard deviation (SD), and coefficient of
variation (%CV) is presented for each population. In addition, the one-sided 95% confidence limit (Upper SD
or Upper %CV) for the total system precision was calculated.

Population
(% of positive) Mean

Repeatability Reproducibility Total precision

SD %CV SD %CV Upper SD Upper %CV

CD27+ 19.85 0.36 1.79 0.53 0.03 0.86 4.33

CD19+ 14.02 0.27 1.90 0.15 0.01 0.36 2.56

CD117+ 5.12 0.15 2.90 0.69 0.13 1.94 37.95

CD81+ 99.08 0.10 0.10 0.56 0.01 1.92 1.94

CD28+ 64.33 0.41 0.64 0.83 0.01 1.64 2.56

CD45+ 29.16 0.53 1.80 1.00 0.03 1.40 4.80

CD38+ 98.76 0.19 0.19 0.69 0.01 1.58 1.60

CD38+CD138+ 99.36 0.08 0.08 0.16 0.00 0.38 0.38

Table 17 Summary of multi-site precision of subset percentages for BD OneFlow™ PCD
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Detection capability (BD OneFlow™ PCD)

The detection capability of BD OneFlow™ PCD was assessed. An abnormal specimen was added to a
hematologically normal bone marrow specimen such that the abnormal population was at 0%, 0.05%, or 0.1%
of all events of the normal specimen. Two sets of abnormal and normal specimens and 2 lots of
BD OneFlow™ PCD were evaluated in the study.

Target population
Expected %

abnormal cells Na

Number
disease
samples

Mean actual %
abnormal cells
(95% CIb)

SD of bias
(Upper 95%

CI)
Trueness (95%
lower bound)

CD45 heterogeneous
CD38+

CD138+

CD19–

CD117 heterogeneous
CD81–

0.000 20 0 0.002
(0.000, 0.001)

N/Ac N/A

0.050 20 20 0.045
(0.040, 0.051)

0.0120
(0.0225)

100
(88.1)

0.100 20 20 0.073
(0.066, 0.081)

0.0163
(0.0306)

100
(88.1)

a. N = Number of replicates

b. CI = Confidence interval

c. N/A = Not applicable

Table 18 Detection capability of BD OneFlow™ PCD

Based on the results, a detection capability of 0.1% of all events is recommended for BD OneFlow™ PCD.

BD FACSCanto™ II Flow Cytometer (BD OneFlow™ PCST)

Method comparison, BD FACSCanto™ II flow cytometer vs EuroFlow system
(BD OneFlow™ PCST)

A side-by-side comparison study between the BD OneFlow™ PCST system on the BD FACSCanto™ II flow
cytometer and the EuroFlow PCST system on the BD FACSCanto™ II flow cytometer was performed. 48 BM
samples were collected at 2 external clinical sites. The BD OneFlow™ PCST system comprises BD OneFlow™
Setup Beads, BD® FC Beads for compensation, and the BD OneFlow™ PCST reagent. The EuroFlow PCST
reference system comprises Sphero™ Rainbow calibration particles (8 peaks), single color stained cells plus
BD® CompBead particles for compensation, and the EuroFlow PCST reagent cocktail. 48 BM samples were
identified as being “Follow-up needed” or “No follow-up needed” using the two systems, and compared.
Samples identified as “Follow-up needed” were further classified as belonging to the plasma cell lineage or
another lineage.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,

a = number of samples “Follow-up needed” for both systems,

b = number of samples ”Follow-up needed” for the BD OneFlow™ system but “No follow-up needed” for the EuroFlow system,

c = number of samples “No follow-up needed” for the BD OneFlow™ system but “Follow-up needed” for the Euroflow system, and

d = number of samples “No follow-up needed” for both systems.

The results for the identification of cells as being “Follow-up needed” or “No follow-up needed” were
tabulated. See the following table.
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Comparator method
(Euroflow PCST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ PCST)

Follow-up needed 29 0 29

No follow-up
needed

0 19 19

Total 29 19 48

Table 19 Agreement for cells being “Follow-up Needed” or “No follow-up needed”

Overall % agreement is 100%.

Results calculated based on 95% lower confidence interval are 93.9% agreement.

The results for samples requiring follow-up for the plasma cell lineage or not requiring follow-up for the
plasma cell lineage were tabulated. See the following table.

Comparator method
(Euroflow PCST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ PCST)

Follow-up needed 22 0 22

No follow-up
needed

0 26 26

Total 22 26 48

Table 20 Agreement for samples requiring follow-up for the plasma cell lineage or not requiring follow-up for the plasma
cell lineage

Overall % agreement is 100%.

Results calculated based on 95% lower confidence interval are 93.9% agreement.

The results for samples requiring follow-up for a non-plasma cell lineage (other lineage) or not requiring
follow-up for a non-plasma cell lineage (other lineage) were tabulated. See the following table.

Comparator method
(Euroflow PCST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ PCST)

Follow-up needed 7 0 7

No follow-up
needed

0 41 41

Total 7 41 48

Table 21 Agreement for samples requiring follow-up for a non-plasma cell lineage (other lineage) or
not requiring follow-up for a non-plasma cell lineage (other lineage)

Overall % agreement is 100%.
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Results calculated based on 95% lower confidence interval are 93.9% agreement.

Equivalency (BD FACSCanto™ II flow cytometer)

Bone marrow specimens collected at 2 external clinical laboratories were obtained from patients with plasma
cell disorders, with other hematological disorders, or with no hematological abnormalities. Specimens were
analyzed side-by-side using the BD OneFlow™ PCST system and the EuroFlow PCST system described
previously. Plasma cells (CD45+, CD38+, CD138+) were identified as being a percentage of the SSC singlets.
cyIgκ+ cells (CD45+, CD38+, CD138+, cyIgκ+, cyIgλ–) and cyIgλ+ cells (CD45+, CD38+, CD138+, cyIgλ+, cyIgκ–)
were identified as being a percentage of plasma cells. Deming regression statistics indicate that the results
obtained using the two systems are substantially equivalent. See the following table.

Marker Sample size Intercept Slope Lower 95% CLa
of slope

Upper 95% CL
of slope

Plasma cells (%SSC) 48 –0.21 0.95 0.70 1.06

cyIgκ+cells (%plasma cells) 46 5.85 0.97 0.85 1.04

cyIgλ+ cells (%plasma cells) 46 3.79 0.95 0.89 1.01

a. CL = Confidence Limit

Table 22 Equivalency of the BD OneFlow™ system to the EuroFlow system

Precision (reproducibility) (BD OneFlow™ PCST)

Two operators performed two separate runs per day over a period of eight days, alternating the runs on two
BD FACSCanto™ II flow cytometers. The reproducibility of CD38, CD56, β2-Microglobulin, CD19, Anti-Kappa,
Anti-Lambda, and CD45 was assessed using BD Multi-Check™ Control. The reproducibility of CD138 was
assessed using BM. For each run, duplicate samples of the appropriate control (BD Multi-Check™ Control or
BM) were stained using three lots of BD OneFlow™ PCST by each operator, acquired using the
BD OneFlow™ PCST Acquisition worksheet, and analyzed using BD FACSDiva™ software. Cell populations
staining positively for CD38, CD56, β2-Microglobulin, CD19, Anti-Kappa, Anti-Lambda, and CD45 were
identified as being a percentage of the parent population (Subset %P). CD138+ cells were identified as being a
percentage of the CD38bright plasma cells (Subset %CD38bright) in BM. The overall reproducibility of Subset %P
was calculated for each of the antibodies. The overall reproducibility comprises four components:
operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and day-to-day reproducibility. See the
following table.

Population DFa SDb %CVc UCLd

CD56+ 95 1.45 11.2 12.56

β2-Microglobulin+ 95 0.15 0.15 0.17

CD19+ 95 0.49 3.27 3.66

cyIgκ+ 95 0.97 1.73 1.94

cyIgλ+ 95 0.73 1.86 2.08

CD45+ 95 1.14 1.19 1.33

CD38+ 95 1.23 11.81 13.24

a. DF = Degrees of Freedom
b. SD = Standard Deviation
c. %CV = % Coefficient of variation
d. UCL = Upper confidence limit of the 95% confidence interval

Table 23 Reproducibility of Subset %P
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The overall reproducibility of Subset %CD38bright comprises operator/instrument-to-operator/instrument, lot-
to-lot, run-to-run, and donor-to-donor reproducibility. See the following table.

Population DF SD %CV UCL

CD138+ 88 7.53 13.58 15.30

Table 24 Reproducibility of Subset %CD38bright

Precision (repeatability) (BD OneFlow™ PCST)

Two operators performed two separate runs per day over a period of eight days, alternating the runs on two
BD FACSCanto™ II flow cytometers. The repeatability of CD38, CD56, β2-Microglobulin, CD19, Anti-Kappa,
Anti-Lambda, and CD45 was assessed using BD Multi-Check™ Control. The repeatability of CD138 was
assessed using BM. For each run, duplicate samples of the appropriate control (BD Multi-Check™ Control or
BM) were stained using three lots of BD OneFlow™ PCST by each operator, acquired using the
BD OneFlow™ PCST Acquisition worksheet, and analyzed using BD FACSDiva™ software. Cell populations
staining positively for CD38, CD56, β2-Microglobulin, CD19, Anti-Kappa, Anti-Lambda, and CD45 were
identified as being a percentage of the parent population (Subset %P). CD138+ cells were identified as being a
percentage of the CD38bright plasma cells (Subset %CD38bright) in BM. The intra-assay precision (tube-to-tube
repeatability) of Subset %P was calculated for each of the antibodies. See the following table.

Population DF SD %CV UCL

CD56+ 96 0.33 2.56 2.87

β2-Microglobulin+ 96 0.08 0.08 0.09

CD19+ 96 0.28 1.84 2.05

cyIgκ+ 96 0.87 1.55 1.74

cyIgλ+ 96 0.82 2.08 2.33

CD45+ 96 0.26 0.27 0.30

CD38+ 96 0.24 2.34 2.62

Table 25 Repeatability of Subset %P

The tube-to-tube repeatability of Subset %CD38bright for CD138 was calculated. See the following table.

Population DF SD %CV UCL

CD138+ 96 2.85 5.13 5.75

Table 26 Repeatability of Subset %CD38bright

BD FACSCanto™ II Flow Cytometer (BD OneFlow™ PCD)

Method comparison, BD FACSCanto™ II flow cytometer vs EuroFlow system
(BD OneFlow™ PCD)

A side-by-side comparison study between the BD OneFlow™ PCD system on the BD FACSCanto™ II flow
cytometer and the EuroFlow PCD system on the BD FACSCanto™ II flow cytometer was performed. 48 BM
samples were collected at 2 external clinical sites from patients with plasma cell disorders, other leukemia or
lymphoma disorders, or no disorder. The BD OneFlow™ PCD system comprises BD OneFlow™ Setup Beads,
BD® FC Beads for compensation, and the BD OneFlow™ PCD reagent. The EuroFlow PCD reference system
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comprises Sphero™ Rainbow calibration particles (8 peaks), single color stained cells for compensation, and
the EuroFlow PCD reagent cocktail. The plasma cell population from 48 BM samples was identified as being
“Follow-up needed” or “No follow-up needed” using the two systems, and compared.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,

a = number of samples ”Follow-up needed” for both systems,

b = number of samples ”Follow-up needed” for the BD OneFlow™ system but ”No follow-up needed” for the EuroFlow system,

c = number of samples ”No follow-up needed” for the BD OneFlow™ system but ”Follow-up needed” for the EuroFlow system, and

d = number of samples ”No follow-up needed” for both systems.

The results for the identification of plasma cells as being “Follow-up Needed” or “No follow-up needed” were
tabulated. See the following table.

Comparator method
(Euroflow PCD cocktail)

Follow-up needed No follow-up needed Total

Investigational method
(BD OneFlow™ PCD)

Follow-up needed 22 0 22

No follow-up needed 0 26 26

Total 22 26 48

Table 27 Agreement for identification of plasma cells as “Follow-up needed” or “No follow-up needed”

Overall % agreement is 100%.

Results calculated based on 95% lower confidence interval are 93.9% agreement.

Equivalency (BD FACSCanto™ II flow cytometer)

Bone marrow specimens collected at 2 external clinical laboratories were obtained from patients with plasma
cell disorders, with other hematological disorders, or with no hematological abnormalities. Specimens were
analyzed side-by-side using the BD OneFlow™ PCD system and the EuroFlow PCD system described previously.
Plasma cells (CD45+, CD38+, CD138+) were identified as being a percentage of the SSC singlets. Deming
regression statistics indicate that the results obtained using the two systems are substantially equivalent. See
the following table.

Marker Sample size Intercept Slope Lower 95% CLa of slope Upper 95% CL of slope

Plasma cells (%SSC) 48 0.26 0.92 0.83 1.08

a. CL = Confidence Limit

Table 28 Equivalency of the BD OneFlow™ system to the EuroFlow system

Precision (reproducibility) (BD OneFlow™ PCD)

Two operators performed two separate runs per day over a period of eight days, alternating the runs on two
BD FACSCanto™ II flow cytometers. The reproducibility of CD38, CD28, CD27, CD19, CD117, CD81, and CD45
was assessed using BD Multi-Check™ Control supplemented with CD-Chex CD117 Plus. The reproducibility of
CD138 was assessed using BM. For each run, duplicate samples of the appropriate control
(BD Multi-Check™ Control with CD-Chex CD117 Plus, or BM) were stained using three lots of
BD OneFlow™ PCD by each operator, acquired using the BD OneFlow™ PCD Acquisition worksheet, and
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analyzed using BD FACSDiva™ software. Cell populations staining positively for CD38, CD28, CD27, CD19,
CD117, CD81, and CD45 were identified as being a percentage of the parent population (Subset %P). CD138+

cells were identified as being a percentage of the CD38bright plasma cells (Subset %CD38bright) in BM. The
overall reproducibility of Subset %P was calculated for each of the antibodies. The overall reproducibility
comprises four components: operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and
day-to-day reproducibility. See the following table.

Population DFa SDb %CVc UCLd

CD28+ 95 0.53 0.71 0.80

CD27+ 95 0.72 1.0 1.12

CD19+ 95 0.18 1.21 1.36

CD81+ 95 1.46 1.53 1.71

CD117+ 95 0.32 5.51 6.18

CD45+ 95 0.50 0.52 0.59

CD38+ 95 2.34 6.07 6.8

a. DF = Degrees of Freedom
b. SD = Standard Deviation
c. %CV = % Coefficient of variation
d. UCL = Upper confidence limit of the 95% confidence interval

Table 29 Reproducibility of Subset %P

The overall reproducibility of Subset %CD38bright comprises operator/instrument-to-operator/instrument, lot-
to-lot, run-to-run, and donor-to-donor reproducibility. See the following table.

Population DF SD %CV UCL

CD138+ 88 8.20 16.22 18.29

Table 30 Reproducibility of Subset %CD38bright

Precision (repeatability) (BD OneFlow™ PCD)

Two operators performed two separate runs per day over a period of eight days, alternating the runs on two
BD FACSCanto™ II flow cytometers. The repeatability of CD38, CD28, CD27, CD19, CD117, CD81, and CD45
was assessed using BD Multi-Check™ Control supplemented with CD-Chex CD117 Plus. The repeatability of
CD138 was assessed using BM. For each run, duplicate samples of the appropriate control
(BD Multi-Check™ Control with CD-Chex CD117 Plus, or BM) were stained using three lots of
BD OneFlow™ PCD by each operator, acquired using the BD OneFlow™ PCD Acquisition worksheet, and
analyzed using BD FACSDiva™ software. Cell populations staining positively for CD38, CD28, CD27, CD19,
CD117, CD81, and CD45 were identified as being a percentage of the parent population (Subset %P). CD138+

cells were identified as being a percentage of the CD38bright plasma cells (Subset %CD38bright) in BM. The
intra-assay precision (tube-to-tube repeatability) of Subset %P was calculated for each of the antibodies. See
the following table.

Population DF SD %CV UCL

CD28+ 96 0.37 0.50 0.56

CD27+ 96 0.35 0.48 0.54

Table 31 Repeatability of Subset %P
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Population DF SD %CV UCL

CD19+ 96 0.25 1.71 1.91

CD81+ 96 0.37 0.39 0.44

CD117+ 96 0.10 1.77 1.99

CD45+ 96 0.36 0.37 0.42

CD38+ 96 0.77 2.01 2.25

The tube-to-tube repeatability of Subset %CD38bright for CD138 was calculated. See the following table.

Population DF SD %CV UCL

CD138+ 96 2.69 5.32 5.95

Table 32 Repeatability of Subset %CD38bright

10. TROUBLESHOOTING

Problems with cell preparation or staining

Problem Possible Cause Solution

The resolution
between debris
and cells is poor.

Specimen was over-
permeabilized.

Repeat staining. Incubate the tube in FIX&PERM® Reagent B for
15 minutes only.

Specimen is of poor quality. Check cell viability.

Specimen is too old. Obtain a new specimen and stain it immediately.

The cytoplasmic
staining (Igκ and
Igλ) is dim.

The cells were not
completely permeabilized.

Repeat staining. Carefully measure the specimen volumes in the cell
fixation and permeabilization steps such that the ratio of fixed
sample to FIX&PERM® Reagent B is 1:1.

Cells clump after
being fixed.

Cells were not completely
resuspended before fixing
them.

Vortex tubes until no cell aggregates remain before adding
FIX&PERM® Reagent A. If needed, gently pipette the sample up and
down until no cell aggregates remain.

Cells were not thoroughly
washed after fixing them.

Incubate the tubes for 2 minutes in the dark in wash buffer after they
have been fixed using FIX&PERM® Reagent A.

Staining is dim or
fading.

Cell concentration was too
high at the staining step.

Check the cell concentration and adjust as needed.

Washed specimen was not
stained within 30 minutes
of the last wash.

Repeat staining with a freshly prepared specimen.

The BD OneFlow™ tube was
exposed to light for too
long.

Repeat staining with a new tube.

Cells were not acquired
within 1 hour of staining.

Repeat staining with fresh specimen. Acquire promptly.

Few or no cells Cell concentration was too Resuspend fresh specimen at a higher concentration. Repeat staining
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Problem Possible Cause Solution

are recorded. low. and acquisition.

Cytometer is
malfunctioning.

Troubleshoot the instrument. See the cytometer instructions for use
for more information.

Problems using the reagents on BD FACSLyric™ flow cytometers:

Problem Possible Cause Solution

Not enough cells of
interest are
acquired.

Cell concentration was too
low.

Resuspend fresh specimen at a higher concentration. Repeat
staining and acquisition.

The default setting of
100,000 events acquired is
too low.

Change the number of events acquired. Repeat staining and
acquisition. See the BD OneFlow™ Application Guide for Plasma Cell
Disorders for BD FACSLyric™ Flow Cytometers.

The FSC-A vs SSC-A
dot plot is
abnormal.

Cytometer needs adjusting. Contact BD Biosciences.

The csv file and
report are not
exported
automatically.

The reagent lot number and
expiration date were not
added to the Library.

1. Add the reagent lot number and expiration date to the Library.
2. Export the csv file and the report PDF manually. See the

BD FACSLyric™ System Instructions For Use.

Problems using the reagents on BD FACSCanto™ II flow cytometers:

Problem Possible Cause Solution

The resolution between
debris and lymphocytes is
poor.

Instrument
settings are
inappropriate.

Follow proper instrument setup procedures. See the Instrument
Setup Guide for BD OneFlow™ Assays.

Some of the dot plots are
dimmed.

FSC-H and SSC-H
were not selected
when the
application
settings were
created.

Check that FSC-H and SSC-H are selected on the Parameters tab of
the Inspector.

The barcode on the
BD OneFlow™ tube label
cannot be scanned.

The barcode on the
tube label has been
compromised.

Scan the barcode on the BD OneFlow™ pouch label into the Product
ID keyword field in the Experiment Layout. Next, manually enter a
semicolon (;) followed by the six-digit tube-specific ID, found
adjacent to the barcode on the tube label, after the last digit of the
barcode.

The dot plots on the
worksheets are missing or
the dot plots do not have
gates.

The template did
not import
correctly.

1. Close the current experiment.
2. Create a new experiment.
3. Re-import the BD OneFlow™ template.

Some of the keywords are
missing from the statistics

BD FACSDiva™
software did not

1. In the Browser, set the current tube pointer to the tube that you
are analyzing.

2. Navigate to the analysis worksheet.
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Problem Possible Cause Solution

box in the analysis
worksheet.

import all of the
keywords into the
panel template.

3. Right-click the statistics box and select Edit Stats View.
4. In the Header tab, select the All checkbox.
5. Click OK.

The statement, For in vitro
diagnostic use, does not
appear in the footer of the
analysis worksheet when it
is printed.

The paper margins
in the printer
settings were
changed.

1. From the BD FACSDiva™ software menu bar, select File > Page
Setup.

2. Ensure that all of the margins are set to 2.54 cm or 1 inch,
depending on your default standards.

3. Click OK.
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NOTICE
EU Only: Users shall report any serious incident related to the device to the Manufacturer and National
Competent Authority.

Outside EU: Contact your local BD representative for any incident or inquiry related to this device.

Refer to the Eudamed website: https://ec.europa.eu/tools/eudamed for Summary of Safety and Performance.

WARRANTY
Unless otherwise indicated in any applicable BD general conditions of sale for non-US customers, the
following warranty applies to the purchase of these products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE QUANTITY AND CONTENTS STATED ON THE LABEL
OR IN THE PRODUCT LABELING AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR PURPOSE AND
NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF THE PRODUCTS OR REFUND OF THE PURCHASE
PRICE. BD IS NOT LIABLE FOR PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING PERSONAL
INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT.

PATENTS AND TRADEMARKS
For US patents that may apply, see bd.com/patents.

BD, the BD Logo, BD FACSDiva, BD FACSLyric, BD FACSuite, BD Multi-Check, BD OneFlow, FACS, FACSCanto,
Horizon and Vacutainer are trademarks of Becton, Dickinson and Company or its affiliates. All other
trademarks are the property of their respective owners. © 2023 BD. All rights reserved.

Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare and
Carnegie Mellon University, and is made and sold under license from GE Healthcare. This product is licensed
for sale only for in vitro diagnostics. It is not licensed for any other use. If you require any additional license to
use this product and do not have one, return this material, unopened, to BD Biosciences, 2350 Qume Drive,
San Jose, CA 95131, and any money paid for the material will be refunded.
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The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property of the EuroFlow
Consortium and cannot be reproduced or published without prior written permission from the EuroFlow
coordinator (euroflow.org).

HISTORY
Revision Date Changes made

23-16816-01 2020-05 Revised to support using the product on BD FACSLyric™ flow cytometers.

23-16816-02 2021-01 Revised to support using the product with the BD FACS™ Universal Loader.

23-16816(03) 2023-01 Updated to meet requirements of Regulation (EU) 2017/746. Merged
BD OneFlow™ PCST and BD OneFlow™ PCD IFUs to support the panel.
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SYMBOLS GLOSSARY [L006715(06) 2021-08]
Some symbols listed below may not apply to this product.
US Customers only: For symbol glossary, refer to bd.com/symbols-glossary

Symbol Meaning
Manufacturer

Authorized representative in the European Community

Authorised representative in Switzerland

Date of manufacture

Use-by date

Batch code

Catalogue number

Serial number

Sterile

Sterilized using aseptic processing techniques

Sterilized using ethylene oxide

Sterilized using irradiation

Sterilized using steam or dry heat

Do not resterilize

Non-sterile

Do not use if package is damaged and consult instructions for use

Sterile fluid path

Sterile fluid path (ethylene oxide)

Sterile fluid path (irradiation)

Fragile, handle with care

Keep away from sunlight

Keep dry

Lower limit of temperature

Upper limit of temperature

Temperature limit

Humidity limitation

Biological risks

Do not re-use

Consult instructions for use or consult electronic instructions for use

Caution

Contains or presence of natural rubber latex

In vitro diagnostic medical device

Negative control

Positive control

Contains sufficient for <n> tests

For IVD performance evaluation only

Non-pyrogenic

Symbol Meaning

Patient number

This way up

Do not stack

Single sterile barrier system

Contains or presence of phthalate: combination of bis(2-ethylhexyl)
phthalate (DEHP) and benzyl butyl phthalate (BBP)

Collect separately
Indicates separate collection for waste of electrical and electronic equipment
required.

CE marking; Signifies European technical conformity

Device for near-patient testing

Device for self-testing

This only applies to US: “Caution: Federal Law restricts this device to
sale by or on the order of a licensed practitioner.”

Country of manufacture
“CC” shall be replaced by either the two letter or the three letter country
code.

Collection time

Cut

Peel here

Collection date

Keep away from light

Hydrogen gas is generated

Perforation

Start panel sequence number

End panel sequence number

Internal sequence number

Medical device

Contains hazardous substances

Ukrainian conformity mark

Meets FCC requirements per 21 CFR Part 15

UL product certification for US and Canada

Unique device identifier

36

http://www.bd.com/symbols-glossary


CONTACT INFORMATION

Becton, Dickinson and Company
BD Biosciences
2350 Qume Drive
San Jose, California 95131 USA

Becton Dickinson Ireland Ltd.
Donore Road, Drogheda
Co. Louth, A92 YW26
Ireland

BD Switzerland Sàrl
Route de Crassier 17
Business Park Terre-Bonne
Bâtiment A4
1262 Eysins
Switzerland

BD Biosciences
European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com

Australian and New Zealand Distributors:

Becton Dickinson Pty Ltd.
66 Waterloo Road
Macquarie Park NSW 2113
Australia

Becton Dickinson Limited
14B George Bourke Drive
Mt. Wellington Auckland 1060
New Zealand

Technical Service and Support: Contact
your local BD representative or
bdbiosciences.com.

ClinicalApplications@bd.com

eifu.bd.com
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